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Installation Instructions and Cautions 

PLEASE NOTE: MAS 90 must already be installed on your system 
before installing any IIG enhancement. If not already done, perform 
your MAS 90 installation and setup now; then allow any updating to 
be accomplished automatically. 
Once MAS 90 installation and file updating is complete, you may 
install your IIG enhancement product by following the procedure 
below. 
 

Wait! Before You Install – Do You Use 
CUSTOM OFFICE? 

THIS IS AN IMPORTANT CAUTION:  If you have Custom 
Office installed, and if you have modified any MAS 90 screens, 
you must run Customizer Update after you do an enhancement 
installation.  
 
But wait! BEFORE you run Customizer Update, it is very 
important that you print all of your tab lists. Running Customizer 
Update will clear all Tab settings; your printed tab list will help you 
to reset your Tabs in Customizer Update. 
Custom Office is installed on your system if there is an asterisk 
in the title bar of some of the screens. The asterisk indicates that 
the screen has been changed. 
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An asterisk in a 
window’s title bar 
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Custom Office is 
installed. 
 
Follow all the 
instructions on 
this page before 
you run 
Customizer 
Update! 
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Registering IIG products 

IIG Enhancement should be registered to be able to use it. If 
registration is not performed, the enhancement will work in a 
demo mode for a limited time period. The registration can be still 
done during the demo period. 
 
Select the IIG Product Registration program under the Library 
Master Setup menu of the MAS 90. 
 
If this option is not listed under the Library Master Setup menu, 
go to the main menu, and select Run from the File menu. Type 
in SVIIGR and click OK. 
 

 
 
Enter Serial Number and Unlocking Key provided by IIG, and 
click OK. 
 
If multiple IIG Enhancements are installed, Serial Numbers and 
Unlocking Keys should be entered for each enhancement. 
 
IIG Registration Form can be printed by using the Print 
Registration Form button. 
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WARNING: 
If IIG Credit Card Processing (CCP) exists in the system, the 
installation order must be the following: 
 
1.CCP 
2.WSA 
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Shipping Automation Setup 

Sales Order Options 
Once the installation of the Warehouse Shipping Automation 
enhancement module is complete, allow the program to 
automatically perform the proper system updates, conversions 
and self-settings upon first launch. From the Sales Order Setup 
menu, select the Sales Order Options program. 
 
Make sure the Enable Shipping box is checked on the Integrate 
tab. 
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Shipping Automation Options 
Select Shipping Automation Options under the Sales Order 
Setup menu. A message will prompt to start conversion of data 
files. Click Yes. If you select No, shipping automation programs 
will not be available. After clicking Yes, the following screen 
will be displayed: 
 

 
 
A warning is displayed, if there is no configured Shipping 
Terminal. Terminals are configured in the Shipping Terminal 
Maintenance under the Sales Order Setup menu. 
 
Check the Charge Actual Freight? box if the actual freight 
amount will be invoiced. Checking this box enables the 
following two options: 
 
Zero Invoice No Charge?  Check this box to allow zero dollar 
invoices to not be charged freight. This is most commonly used 
with "no charge" replacement invoices. 
 
Prepaid Freight Allowed?  Check this box if allowing freight 
charges to not be charged. 
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Check the Charge COD Fee Extra box if the COD fee should 
be added to the invoice freight amount. This amount is calculated 
based on the carrier, when not Charging Actual Freight. 
 
Check the Charge Handling Fee? box if the customer will be 
charged for the handling of the package. Enter the amount the 
customer will be charged. Select the Per Parcel checkbox to 
specify that the handling fee that was entered will be applied to 
each individual parcel. If the Per Parcel checkbox is not 
selected, the handling fee that you entered will be applied to the 
entire shipment, regardless of how many individual parcels it 
contains. 
 
Note: The handling fee will be added to the invoice freight 
amount. 
 
Check the Default Declared Value? box to attach a declared 
value based on the invoice amount. Leaving this option 
unchecked will not apply a declared value to the shipment. 
 
Check the Default Signature Required box to turn on the 
Signature Required box in IIG Manifesting as the default per 
shipment. 
 
Check the Require Box Distribution box to forbid distribution 
of additional boxes when manifesting. The box distribution will 
be limited to the boxes entered in the Shipping Data Entry. 
 
Enter A/R Terms Code for COD and COD Cash Only 
shipments. These terms specify to the system whether a COD 
shipment requires cash only or if a check is acceptable. 
Note: The Terms Codes for “COD” and “COD Cash Only” 
should be created in the Accounts Receivable Terms Code 
Maintenance before the Terms Code may be used here.  
 
In the Export group, you can enter Export License, License 
Expires, and Shipper EIN. 
 
If the following on-line carrier programs: CPS (Computerized 
Parcel System), CLIPPERSHIP, FedEx PowerShip, or 
Malvern Site Server are installed, select the corresponding 
check boxes in the Shipping Automations Options screen.  
 
Check the Close Manifest by Batch box to be able to close the 
manifest by the specified Batch Number. In this case you can add 
new shipment to the selected batch number after closing the 
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Manifest. You cannot add shipments to any batch in case the 
Manifest has been closed for all batches. 
 
If the Subtract B/O Qty from Qty to Ship box is checked, the 
Qty to Ship is displayed instead of the Ordered Quantity in the 
Lines tab of the Shipping Data Entry program and it is 
calculated according to the following formula:  
  
Qty to Ship = Quantity Ordered – Backordered (data taken from 
the Sales Order).  
This option is functioning only for standard orders. 
 It is not available for Kit or Non-inventory items. 
The following message appears when trying to change this 
option while there is even one Shipping Batch in your system. 
 

 
 
The Display uncompleted lines in red box if checked, during 
Shipping Data Entry each uncompleted line will have the SHIP 
and DIST line statuses marked in red.  
  
If the Play WAV sound on some ship errors box is checked, 
WAV file will play if one of the lines has not been completely 
shipped. Otherwise, (if the box is unchecked) it will just beep.  
  
Note: Any WAV file can be used, but it must have 
IIG_SHIP_ERROR.WAV file name and be put in the 
\mas90\soa folder. If MAS200 is running, do the same for any 
workstation.  
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Shipping Terminal Maintenance 
In the Shipping Terminal Maintenance screen, specify the 
workstations that will be manifesting shipments and options used 
for calculating carrier charges. 
 
At least one Terminal ID should be setup.  
 

 
 
Enter Terminal ID or click the Current Terminal ID button. 
 
Enter Description of the terminal. 
 
Enter Location of the terminal. 
 
The Scale Port is the ID number of the communication port to 
which the weight scale will be connected. 
 
Note: The selected communication port will be used for reading 
the scale, when CPS is not installed.  Currently, only 
Weightronix scales are supported. 
 

 
Check the Auto Increment Quantity box to add to quantity 
automatically for the selected terminal. 
 
Check the Force CUI Manifest Print box to print CUI 
Manifests. 
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Note:  The following group of fields will only appear when the 
FedEx Powership Installed box is checked in IIG Shipping 
Automation Options.
 
TWB Printer is the FedEx Label printer UNC share path for the 
FedEx Shipmanager Server to print the thermal label to.  We 
strongly recommend that the path assignments be as short as 
possible.  If at all possible, limit them to 20 characters total. 
 

FedEx Interface Maintenance 
Select the FedEx Interface Maintenance program under the 
Sales Order Setup menu. 
 

 
 
Enter Warehouse Code, or select it using the Lookup button. 
 
Enter a Shipper Address, Telephone number, and Contact 
person for each location. This information will appear on the 
shipping label. 
 

 
INFORMATION INTEGRATION GROUP  877.475.4092 
457 PALM DRIVE  WWW.IIGSERVICES.COM 
GLENDALE, CA 91202 



Warehouse Shipping Automation 4.05 12 
 
Clicking the COD Return Address button opens the FedEx 
COD Return Address screen, where you can enter the COD 
Return Address information. 
 

 
 
In this screen, you can use the Copy Shipper Address to COD 
Address button, to use the same address. 
 
 
The SAS Code is assigned by Federal Express and is used for 
International shipping. 
 
The Shipper Account Number and Master Meter Number are 
assigned by Federal Express. 
 
Enter the Release Auth. No. (Release Authorization Number), 
which will allow your shipments to be delivered without an adult 
signature.  You must have a signed release on file with Federal 
Express. 
 
Check the Use FedEx Printers? to enable the FedEx server to 
print directly to the shipping workstation label printer.  The label 
printer is set up in the Shipping Terminal Maintenance. It is 
recommended that the path assignments be as short as possible 
(maximum: 20 characters). 
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The Server IP Address is to be assigned by your company’s 
System Administrator. This is the IP Address of the FedEx 
Powership server. 
 
The Powership Port Number is assigned by Federal Express. 
This identifies the TCP/IP port on the FedEx Powership server 
(usually 2000). 
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Shipping Rate Maintenance 
In order to use a carrier automation system, such as CPS, 
Clippership, or FedEx, setup the proper Shipping Interface Code 
for each Ship Via code. The Shipping Rate Maintenance 
program under the Sales Order Setup menu has been modified 
to enable Shipping Interface setup. 
 

 
 
Select each Shipping Code to be used. 
  
From the Weight Calculation Method drop-down list, select 
one of the following: Auto Use Next Weight from  
Table, Use Flat Rate Times Ship Rate, or Use Individual 
Weights & Manual Entry. 
 
Note: “Use Individual Weights & Manual Entry”is the preferred 
choice if using “Charge Actual Freight” in IIG Shipping 
Automation Options. 
 
Shipping Interface: From the drop-down list, select the 
appropriate carrier automation software. Depending on the 
carrier automation software installed, enter the corresponding 
Carrier Code and Service Type according to the lists in the 
Appendices (Appendix A for CPS; Appendix B for Clippership; 
Appendix C for FedEx). 
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Mark Up %: In this field, enter the percentage of the actual 
freight charge you want to mark up or down. (Enter a minus sign 
before number for a mark down percentage.) This is available for 
Charge Actual Freight only. 
 

IIG Carrier Maintenance 
Select the IIG Carrier Maintenance program under the Sales 
Order Setup menu. 
 

 
 
Here you can setup more advanced carrier options for the 
Shipping Codes defined in the Shipping Rate Maintenance 
program. 
You can add new Shipping Codes just from this screen. 
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IIG Bill of Lading Options 
Select the IIG Bill of Lading Options program under the Sales 
Order Setup menu. 
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Box Dimension Code Maintenance 
Shipping Automation allows the setup of codes for packaging 
types that are shipped on a regular basis. Select the Box 
Dimension Maintenance program from the Inventory 
Management Setup menu. 
 

 
 
For each Box Dimension Code, enter a description, box 
dimensions, and, if applicable, a Weight Factor (used to account 
for the weight of pallets). Box dimensions are in centimeters if 
the Metric Dimensions is checked, and the Weight Factor will 
be in kilograms.  Otherwise, this is inches and pounds. 
 
The Additional Handling can also be set. 
 
The Bill of Lading Description is set automatically and can be 
changed. 
 
The UPS Box Type Code is set for UPS identification. 
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Item Freight in Inventory Maintenance 
Select the Inventory Maintenance program under the 
Inventory Management Main menu. Select an item. 
 

 
 
Click the IIG Freight button.  
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The following Item Freight Additional Fields screen is 
displayed: 
 

 
 
Upon clicking the Tare Processing button, the IIG Item 
Freight Packaging/Tare Parts screen opens. 
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Enter the Each Tare, Inner Pack Tare, Case Pack Tare, 
Master Pack Tare and Pallet Pack Tare unit of measures and 
their associated Box Codes, Heights, Lengths, Widths and 
Defaults to specify how the product will be shipped for rating. 
Only one of these five check boxes can be checked. 
 
After defining each of the above fields, select one of the left side 
check boxes to use only one Packaging/Tare. 
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Shipping Options in Customer Maintenance 
Select the Customer Maintenance program under the Accounts 
Receivable Main menu. 
 

 
 
 
Click the Options button to specify the shipping options in the 
IIG Special Shipping Options screen: 
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Select the Billing Option. Choose from the following options: 
Shipper, Recipient, Third Party, Consignee or Freight collect.  
 
For all the selections except for Shipper, enter Payor Account 
Data. 
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Shipping Automation Activity 

Shipping Options in Sales Order Entry 
While creating a new sales order in the Sales Order Entry 
screen, shipping options can be specified by clicking the Ship 
Options button located on the Header tab of the Sales Order 
Entry screen. 
 

 

Ship Options 
 
 
 
 
Click the Ship Options button to open the Special Shipping 
Options screen. 
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Depending on what was selected in the Header tab of the Sales 
Order Entry screen, the chosen shipping method will be 
displayed in the Ship Via fields within the Special Shipping 
Options screen. 
 
All of these settings are defaulted from the Shipping Options 
accessed (and, initially, set up) through the Accounts Receivable 
module’s Customer Maintenance screen. 
 
Select the Delivery Period from the drop-down list. Choose 
from the following three options: Weekday, Saturday, or Sunday 
delivery. 
 
Check the Residential Delivery? box if shipment is a residential 
delivery. 
 
Check the Inside Delivery? box if shipment is an inside 
delivery. 
 
Check the Signature Required? box if a signature is required at 
delivery. 
 
Select the Billing Option from the drop-down list. Choose from 
the following options: Shipper, Recipient, Third Party, 
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Consignee or Freight Collect. For all the selections except for 
Shipper, enter Payor Account Data. 
 
Select the foreign Destination Country using the Lookup icon 
if the shipment is not being sent to a US destination. 
 
Select the appropriate Terms of Sale from the drop-down list, if 
this is an international shipment. 
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Shipping Data Entry 
To start shipping, you must first open a manifest in either of the 
IIG/Best Shipping/Manifesting or IIG Manifest Processing 
programs. 
 
Select the Shipping Data Entry program from the Sales Order 
Shipping menu. 
 

 
 
Select the Shipper ID and Order Number to be shipped. 
 
The program loads all the lines of the order. 
 
The Current Package field displays the current package 
number, where everything is shipped. To change the current 
package, click the Next Package No. button. The items will be 
shipped to the new package. 
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Fast Case Processing enables easy way to distribute large 
quantities to large number of cases. 
 
The Fast Case Processing can be used for a line only once and 
only before accepting the entry. 
 
Clicking the Cases… button opens the Fast Case Generation 
for the selected line, if there is Quantity Shipped specified (and 
if the generation has not been done before): 
 

 
 
Enter the Quantity Per Case, which will calculate how many 
cases will be generated for the Quantity Shipped. If the 
Quantity Shipped is not a multiple of the Quantity Per Case, the 
quantity remaining after distributing to complete cases will be 
placed in a separate case (which will remain incomplete). 
 
Check the Include Case 1 box, to include the first case in the 
distribution being generated clearing the contents of the first 
case. 
 
If the quantity of the selected line has already been distributed 
before starting the Fast Case Generation, the program will clear 
that previous distribution. 
 
The generated distribution can be seen in the Item Packaging 
Maintenance. 
 
The Item Packaging Maintenance has been modified to allow 
more convenient parcel managing. 
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(In our example, each of the generated cases includes 10 units of 
the item. The last one has the remaining from the division 
quantity of 8.) 
 
The Cases… button will be disabled for that line on the 
Shipping Data Entry screen. 
 
When this screen is first entered, the parcels where product is 
allocated are shown in the Parcels list box, and any unallocated 
items are show in the Items on Order list box. 
Selecting a parcel line in the Parcels list box will display the 
contents of that parcel in the Package Contents list box. Moving 
the products from Package Contents to Items on Order allows 
those items to be allocated to other parcels. Moving all items 
from Package Contents for that parcel results in the parcel being 
deleted. 
 
 
The Next Parcel button generates the next available parcel 
number for the operator to allocate items to. This is disabled if 
there are no items to allocate. 
 
The Delete Parcel button is enabled when a parcel is selected. 
When a parcel is deleted, the items in that parcel are moved to 
the Items on Order list box for allocation. 
 
The Copy Parcel button is enabled when a parcel is selected and 
the items in the parcel are also in the Items on Order list box to 
allocate. Clicking it creates a new parcel with the same items up 
to the quantity to allocate. For example: 
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There are three items, each with a quantity of 5, and, of the three 
items, one item has only a quantity of three remaining to 
allocate; then pressing the Copy Parcel button will generate a 
new parcel with two items with a quantity of 5 allocated, the 
third item with 3 allocated, and the fully allocated item is 
removed from the Items on Order list box. 
 
The Bulk Copy button does what the Copy Parcels does, but 
keeps going until all items are allocated from the Items on 
Order list box. This allows the operator to create a “template” 
box and copy it to allocate all items to boxes. This is especially 
handy in the apparel business, where it is not uncommon to have 
four to six different sizes in a box, and sixty boxes to process. 
 
The Accept button accepts and writes the parcel contents in the 
Package Contents list box. 
 
The Cancel button undoes changes made in the Package 
Contents list box. 
 
The OK button accepts and closes the dialog. A warning 
message will be displayed if there are unallocated items in the 
Items on Order list box, which will allow return to allocating 
boxes. 
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Go to the Shipping tab of the Shipping Data Entry. 
 
Clicking the Item Packaging button allows maintaining the item 
packaging. 
 

 
 
Click the Tracking… button to view the Summary Package 
Tracking Maintenance screen. 
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The IIG Ship fields have been added to this screen. 
 
Click the IIG Shipping button on the Shipping Data Entry 
screen to proceed to IIG Manifest Generation. 
 
The IIG Ship fields on the Summary Package Tracking 
Maintenance will display information after accepting the 
Shipping. Select the shipping again, and click the Tracking… 
button: 
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When a Shipping Data Entry is accepted, an invoice is generated. 
The Number of invoice is the same as the Number of Shipping. 
 
The shipping information can be viewed by clicking the 
Tracking button on the Header tab of the Invoice Data Entry 
screen. 
 
Shipping information cannot be modified in the generated 
invoice. 
 
Generated invoice cannot be deleted from Invoice Data Entry. 
The Shipping should be deleted instead (which will delete the 
invoice, too). 
 
If the order is already manifested, its shipping cannot be opened 
in the Shipping Data Entry program, until the order is removed 
from the Manifest. 
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Clicking OK opens the Manifest to Void it, if necessary, after 
which the Shipping is opened. 
 

Manifest Processing 
Manifest processing features can be accessed by selecting the 
IIG Manifest Processing or IIG/Best Shipping/Manifesting 
programs from the Sales Order Shipping menu. 
 

 
 
Manifest Generation/Shipping allows user to create a Shipping 
Data Entry, and proceed to Manifest Generation. 
 
Selecting the Open Manifest option will set all proper files to 
begin shipment manifesting. 
 
New Manifest cannot be opened until the current manifest is 
closed. 
 
Click the Proceed button. 
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When the manifest is opened, select the Manifest Generation 
option and click Proceed to generate manifest for sales order. 
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Select an Order, and enter Total Parcels number. 
The Customer No. field displays the customer specified for the 
selected order. 
 
You can view/edit Shipping Options and view Ship To 
Address information by clicking the corresponding buttons. 
 
The Parcel display-only field displays the selected Parcel 
number or current next number of the Parcel to be entered. 
 
Select Box Type and enter the Ship Weight for the current 
Parcel. 
 
Use the OK button to save changes to the selected Parcel, Undo 
to discard them, or Del to delete the current Parcel information. 
 
You can facilitate entry of the parcels by clicking the Load 
Weights button. 
 
The IIG Bulk Parcel Processing screen will be opened. 
 

 
 
The Total Parcels and Total Weight values are displayed from 
the Manifest and can be changed here. 
 
The Allocated Wt. displays sum of the weights of already 
allocated parcels. 
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To allocate multiple parcels at once, in the Parcel Template 
part, enter Parcel Weight, select Box Type, and enter the 
Number of Cartons to Generate. 
 
Click the Generate button to generate parcels with the selected 
settings. 
 
The Total Allocated Parcels displays the number of already 
allocated parcels. 
 
You can create parcels for the weight not allocated yet by 
selecting the Box Type and clicking the Split Evenly button. 
The program will automatically create the necessary number of 
parcels of the selected Box Type to allocate the remaining weight 
(the difference of the Total Weight and Allocated Weight). 
 

 
 
All the fields on the screen become display-only after splitting 
the weight. 
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Return to the IIG Manifest Generation screen to view the 
allocated parcels. 
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Click the SED button to enter the Shipper’s Export Declaration 
information.  
 

 
 
In the opened dialog box enter the FTSR Exemption and Federal XTN code. 
This information will be send to the carrier automation system (only CPS).  
 
Note: This will work only if the Shipping Interface is CPS, and the International 
Shipment? option is checked in the IIG Carrier Maintenance.     
 
The SED information will become display-only after manifesting.  
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Click the Ship button to proceed. 
 

 
 
The parcels are assigned Tracking Numbers. 
 
You can view the SED information after shipping by clicking the SED button:  
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You can use the Void button to delete an existing order manifest. 
 
The same IIG Manifest Generation program is available from 
the Shipping Data Entry program. 
 
After manifesting, the invoice printing contains information on 
shipment (Shipped via, Parcels, Boxes, Weights, Tracking 
Numbers). 
 

 
 
To close a manifest, run the Manifest Processing program under 
the Sales Order Main menu, select the Close Manifest option, 
and click Proceed. 
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A message is displayed asking for confirmation to close the 
manifest. 
 
Note: Closing Manifest will transfer all daily information to 
history after Daily Sales Journal/Update. That information will 
be available in the Invoice History Inquiry. 
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After running the Daily Sales Update, select the Invoice 
History Inquiry program from the Sales Order Inquiries menu. 
 

 
 
Click the IIG Tracking button to view the shipment 
information. 
 

 
 
Clicking the Tracking button also displays that information: 
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The Lines tab of the Invoice History Inquiry displays comment 
lines, added during the Daily Sales Update. 
 

 
INFORMATION INTEGRATION GROUP  877.475.4092 
457 PALM DRIVE  WWW.IIGSERVICES.COM 
GLENDALE, CA 91202 



Warehouse Shipping Automation 4.05 44 
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Manifest Inquiry 
Manifests can be viewed using the Manifest Inquiry program in 
the Sales Order Inquiries menu. 
 

 
 
The closed manifests can be viewed in the History tab by 
Invoice Number, and the open manifests can be viewed in the 
Daily tab by selecting Package Number. 
 

 
INFORMATION INTEGRATION GROUP  877.475.4092 
457 PALM DRIVE  WWW.IIGSERVICES.COM 
GLENDALE, CA 91202 



Warehouse Shipping Automation 4.05 46 
 

 
 
In the Daily tab, click the Daily Totals button to view the current 
information on all the packages of the day. 
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Invoices Not Manifested Report 
The Invoices Not Manifested Report program under the Sales 
Order Inquiries menu prints a list of the invoices shipped with 
the Shipping Automation system and not manifested yet. 
 

 
 
The Sales Journal cannot be updated until these orders are 
manifested or voided. 
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Invoices Without Tracking Numbers 
 
Select the Invoices Without Tracking Numbers program under 
the Sales Order Report menu. The program prints the list of 
invoices that do not have Tracking numbers. These can be 
invoices created without Shipping, invoices creating with 
shipping but not manifested. 
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A/R Shipping History Report 
Select the IIG Shipping History Report program under the 
Accounts Receivable Reports menu. The programs prints the 
list of invoices with their Tracking IDs. 
 

 
 
Here is an example of the printout without Invoice Detail 
Information: 
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This is an example of the printout with the Invoice Detail 
Information: 
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Shipping Rate Shop In Sales Order Entry 
The Rated Freight field on the Totals tab of Sales Order Entry 
displays the Rated Freight of the Ship Via selected from the 
IIG Shopping Rate screen.  
 

 
 
Click the Rate Shop.. button to provide the Rate for each 
Service Type. 
 
The IIG Rate Shopping screen is opened and you can select the 
Ship Via with corresponding Service Type, Carrier Code and 
Freight. 
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Upon the Ship Via selection, the corresponding Rated Freight 
is populated in the Rated Freight field. 
 
The Ship Via field on the Sales Order Header will be replaced 
with the selected Ship Via. 
 
The purpose of this function is when the rating processing is 
working through the products on the order, many of their 
products are always shipped as separate box due to the 
dimensions of the item. 
 
So when the rating program is looping through the product 
ordered to determine what boxes the product can go into, these 
items will be treated as a separate box with nothing else in it.  
The rating process will add the box factor to the item’s weight 
and use that (along with the dimensions) to generate a rating 
transaction. 
 
Products that are not always shipped as a separate box are added 
to the first box until the weight reaches the user set value in the 
Shipping Automation Options (Maximum weight per box for 
rating), which will default to 60 pounds. Once box weight 
exceeds this threshold, increment the box count and continue to 
accumulate in the next box number. 
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Here is how the logic of Rate Shopping works in Sales Order 
Entry. The following 2 cases may occur: 
 

1. Products are shipped as separate box due to the 
dimensions of the item (these items will be treated as a 
separate box with nothing else in it). 

2. Products are not shipped as a separate box (such items 
can be added in the same box until the weight exceeds the 
value set in the Shipping Automation Options). 

 
1. Item shipped as one box 
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The Ship as One Box is set for 1001-HON-H252 Item. 
 

 
 
For selected “002” Box Code Weight Factor will be 3. 
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If the customer orders five of this item: 
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Rate shop showing five cartons at 65 pounds total. 
 
The Formula of Weight for each item will be the following: 
 Item Weight  + Weight Factor    
 
If a widget is 10 pounds, and the box factor is 3 pounds, then: 

• Box 1 will be sent with dimensions 20 x 30 x 50, weight 
13 pounds 

• Box 2 will be sent with dimensions 20 x 30 x 50, weight 
13 pounds 

• Box 3 will be sent with dimensions 20 x 30 x 50, weight 
13 pounds 

• Box 4 will be sent with dimensions 20 x 30 x 50, weight 
13 pounds 

• Box 5 will be sent with dimensions 20 x 30 x 50, weight 
13 pounds 

 
Adding the same item sold with FOUR U/M. 
 

 
 
Rate shop now shows six boxes at 108 pounds, one at 43 
pounds, five at 13 pounds. 
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2. Products are shipped as a separate box: 
 
The Ship as one box is not checked. 
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Same shipment of nine total units sold. 
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Same total weight, but now three boxes, 2 at 43 pounds, one at 
10 pounds. 
 

 
 
The Formula of Weight for this item will be the following. 
UOM conversion factor * item weight + box factor 
 
If a widget is 10 pounds, and the box factor is 3 pounds, then: 

• Box 1 will be sent with dimensions 20 x 30 x 50, weight 
4*10+3 = 43 pounds 

• Box 2 will be sent with dimensions 20 x 30 x 50, weight 
43 pounds 

• Box 3 will be sent with dimensions 20 x 30 x 50, weight 
10 pounds 

 
So the Default Box code (by unit of measure) and Ship as one 
box flags allow the rating transaction to determine what the 
freight is really likely to be. 
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Appendix A: CPS Upgrade Procedure for 2006 
1. Before you start the upgrade, close out Daily Entry on the master station and move to 

history.  Exit Daily Entry. 
2. Run CPS Tools. Select File > Rebuild > Structures. This will clean up any data corruption. 
3. While still in Tools, select File > Rebuild > All. This will rebuild the file indexes. Exit 

Tools. 
4. Back up the CPSW folder to another location. 
5. Install the CPS update CD.  For 2006 the CPS CD will have say 20060102A as the version 

number.  Click Accept on all of the prompts. 
6. When the installation completes, remove the CPS CD.  You may have to reboot the 

computer. 
7. Run Daily Entry. Click Accept to the various carrier service agreements. CPS may advise 

you that there is a service pack available. If so, then click yes to get the service pack.   
8. If Daily Entry does not advise you of the service pack at this point, then exit Daily Entry.  

Go to Start > Programs > CPS for Windows > Update CPS.  The program will check for 
and install the current service pack.  Click Finish when the screen in the background 
appears.  After a few seconds the status display will go away. 

9. After the service packs are installed, run CPS Tools and select File > Rebuild > Structures.  
Then select File > Rebuild > All.  Exit Tools. 

10. Run Daily Entry.  Allow it to come up, and then exit if there are no messages. 
11. If you don’t have any slave stations, you can skip steps 12 through 15. 
12. Now, do the slave stations, one at a time. Do not run anything on the Master station until 

each of the slave stations is completed. 
13. Install the CPS CD on the slave station.  It will do the installation, at the end of which it 

may advise you that the system must be commissioned.  Click okay and ignore this 
warning. 

14. Run Daily Entry.  Daily Entry on the slave station should detect there is a service pack to 
install from the master station.  It should install automatically like the service pack did on 
the main station.  Click Finish when the background dialog appears. 

15. Run Daily Entry on the slave station again.  If it comes up as ready, then exit and go on to 
the next slave station. 
 

Issues you may run into: 
• You must install as an administrator for the local machine. Otherwise, critical files and 

registry entries will not be updated. 
• UPS "Worldship" labels may not show the lower document tab when it was there before.  

Contact CPS to help you correct this.  Advise the tech that you made a backup before you 
installed on the main system (you did do the back in step 4, didn't you?).  He will probably 
have you copy a file from the backup to resolve this issue. 

• USB printer drivers for the Eltron Orion or the older UPS printers may be flaky.  You may 
need to upgrade to a current printer to use the USB printers. 

 
IIG Tech Support, original January 18, 2006, revised March 31, 2006. 
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Appendix B: CPS settings 

The following settings should be done in CPS, on each 
workstation using CPS, to enable correct processing. 
 
In the Tools > Environment Variables: 
  
Set these options to YES: 
AUTOINCREMENT, 
BYPASSINVOICE, 
NOF5DVMLOOKUP, 
NOUPSDVMESSAGE. 
  
In the Tools > Setup > Optional Label Information:   
  
Label 1 - "Ref 1:" Field REF_1,  
Label 2 - "Ref 2:" Field REF_2 
 
 
For Residential, you must set up separate Ship Via codes for CPS 
to work correctly. 
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UPS Common Carrier Service  Code   Service
Next Day Early A.M.    @@15   UPS 
Next Day Early A.M. Letter   @L15 
Next Day Air or Express    @@01 
Next Day or Express Letter   @L01 
Next Day Air Saver    @@13 
Next Day Air Saver Letter    @L13 
2nd Day Air A.M.     @@07 
2nd Day Air A.M. Letter    @L07 
2nd Day Air or Expedited    @@02 
2nd Day Air Letter    @L02 
3 Day Select Commercial    @@12 
3 Day Selected Residential   @R12 
Commercial Ground    @@03 
Residential Ground    @R03 
 

UPS Hundredweight Service 
 
Next Day Air     @@01   UPH 
Next Day Air Saver    @@13 
2nd Day Air A.M.     @@07 
2nd Day Air     @@02 
3 Day Select Commercial    @@12 
Commercial Ground    @@03 
Residential Ground    @R03 
3 Day Select Residential    @R12 
 

International UPS Shipment Service 
 
Express      @@66 or @@01  UPW 
Express Letter     @L66 or @@01 
Express 10 KG Box    @A66 
Express 25 KG Box    @B66 
Express Extended Area    @X66 
Express Extended Area Letter   @Y66  
Express Extended 10 KG Box   @C66 
Express Extended 25 KG Box   @D66 
Expedited     @@67 or @@02 
Expedited Extended Area    @X67 
Standard      @@68 
Express Plus     @@54 
Express Plus Letter    @L54 
Express Plus 10 KG Box    @A54 
Express Plus 25 KG Box    @B54 
Express Plus Extended    @X54 
Express Plus Extended Letter   @Y54 
Express Plus Extended 10 KG   @C54 
Express Plus Extended 25 KG   @D54 
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FedEx Domestic Service 
 
Priority Overnight Service    @@01   FEX 
Priority Overnight Letter    @L01   Note: No electronic  
Standard Overnight Service   @@13   upload available at   
Standard Overnight Letter    @L13   present for FedEx. 
First Overnight Letter    @L15 
2Day Service     @@02 
Express Saver Service    @@08 
 

RPS North America Service 
 
2 Day Air Guaranteed    @@01   RPS 
2 Day Residential     @R01 
3 Day Air Guaranteed    @@12 
3 Day Residential     @R12 
U.S. Commercial Ground    @@44 
U.S. Residential Ground    @R44 
Hawaii Deferred Air    @@44 
Hawaii Deferred Residential   @R44 
Hawaii Deferred Outer-Is    @@44 
Hawaii Residential Outer-Is   @R44 
Alaska Deferred Air    @@44 
Alaska Residential Deferred   @R44 
Alaska Rural Deferred    @@44 
Alaska Rural Residential    @R44 
PR Deferred Air     10 
PR Deferred Residential    R10 
Canada Ground     @@44 
Canada Residential Ground   @R44 
Mexico Deferred Air    @@44 
Mexico Deferred Residential   @R44 
Mexico Extended     @X61 
Mexico Extended Residential   @Z61 
 

USPS Domestic Service 
 
Express Mail     @@01   USP 
Priority Mail     @@02 
Parcel Post Machinable    @@03 
Parcel Post Non-Machinable   @@08 
Parcel Post Local     110 
Special Std. Mail (single)    @@12 
Express Mail Flat Envelope   @L01 
Priority Mail Flat Envelope   @L02 
 

SPD Domestic Service 
SpeeDee Ground     @@03   SPD 
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Appendix C: Clippership Carrier List* 

Carrier Code       Carrier Description
 
 A01 Airborne Express *For all codes, enter a “C” 
 A02 Airborne Express Letter (minus quotes) in the Service  
 A03 Airborne Second Day Type field. 
 A04 Airborne Second Day Letter 
 A05 Airborne NAS 
 A06 Airborne NAS Letter 
 A07 Airborne Deferred 
 A08 Airborne Deferred Letter 
 A09 Airborne Express Zone 
 A10 Airborne Express Letter Zone 
 A11 Airborne Second Day Zone 
 A12 Airborne Second Day Letter Zone 
 A13 Airborne NAS Zone 
 A14 Airborne NAS Letter Zone 
 A15 Airborne Deferred Zone 
 A16 Airborne Deferred Letter Zone 
 B01 BAX Global Overnight 
 B02 BAX Global Overnight Letter 
 B03 BAX Global Second Day 
 B04 BAX Global Deferred 
 D01 DHL Worldwide Priority Express (Non-Doc) 
 D02 DHL Int'l Document Service (Package) 
 D03 DHL Int'l Document Service (Exp-Doc) 
 D04 DHL USA Overnight (Package) 
 D05 DHL USA Overnight (Exp-Doc) 
 F01 FedEx Priority Overnight 
 F02 FedEx Priority Overnight Letter 
 F03 FedEx Priority Overnight Pak 
 F04 FedEx Priority Overnight Box 
 F05 FedEx Priority Overnight Tube 
 F06 FedEx Standard Overnight 
 F07 FedEx Standard Overnight Letter 
 F08 FedEx Standard Overnight Pak 
 F09 FedEx Standard Overnight Box 
 F10 FedEx Standard Overnight Tube 
 F11 FedEx 2 Day 
 F14 FedEx Express Saver 
 F15 FedEx Overnight Freight (1 Day) 
 F16 FedEx Economy 2 Day Freight (2 Day) 
 F17 FedEx ES Distance Based Freight (3 Day) 
 F18 FedEx First Overnight 
 F19 FedEx First Overnight Letter 
 F20 FedEx 2 Day Letter 
 F21 FedEx 2 Day Pak 
 F60 FedEx International First Letter 
 F61 FedEx International First Pak 
 F62 FedEx International First 
 F63 FedEx International Priority Letter 
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Carrier Code       Carrier Description
 
 F64 FedEx International Priority Pak *For all codes, enter a “C” 
 F65 FedEx International Priority (minus quotes) in the Service  
 F69 FedEx International Economy Type field. 
 F71 FedEx International Priority 10KG Box 
 F72 FedEx International Priority 25KG Box 
 P01 USPS First Class Regular 
 P02 USPS First Class Presort 
 P03 USPS First Class Priority 
 P04 USPS Express ( PO to Address ) 
 P05 USPS First Class Priority Flat Rate 
 P06 USPS Express ( PO to Address ) Flat Rate 
 P32 USPS Standard A Bulk 
 P41 USPS Standard B Machinable 
 P42 USPS Standard B Non-Machinable 
 P43 USPS Standard B Intra-BMC 
 P44 USPS Standard B Destination BMC 
 P45 USPS Standard B Special 
 P46 USPS Standard B Library Rate 
 P47 USPS Bound Printed Matter ( single ) 
 P48 USPS Bound Printed Matter ( bulk ) 
 P60 USPS International Air Letter 
 P61 USPS International Air Small Packet 
 P62 USPS International Air Printed Matter 
 P63 USPS International Air Parcel Post 
 P64 USPS International Air Books/Music 
 P65 USPS International Air Periodicals 
 P66 USPS International Air Prnt. Mtr. M-Bag 
 P67 USPS International Air Bks/Music M-Bag 
 P68 USPS International Air Periodicals M-Bag 
 P69 USPS International Surf Small Packet 
 P70 USPS International Surf Printed Matter 
 P71 USPS International Surf Parcel Post 
 P72 USPS International Surf Books/Music 
 P73 USPS International Surf Periodicals 
 P74 USPS International Surf Prnt. Mtr. M-Bag 
 P75 USPS International Surf Bks/Music M-Bag 
 P76 USPS International Surf Periodical M-Bag 
 P77 USPS International Custom Express 
 P78 USPS International Demand Express 
 P79 USPS International Global Priority Std 
 P80 USPS International Global Priority Small 
 P81 USPS International Global Priority Large 
 R01 RPS Prepaid Air 
 R02 RPS Prepaid Ground 
 R04 RPS Prepaid Canada 
 R06 RPS Collect Air 
 R07 RPS Collect Ground 
 R09 RPS Collect Canada 
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Carrier Code       Carrier Description
 
 R13 RPS Prepaid Ground Mexico *For all codes, enter a “C” 
 R17 RPS Multiweight Ground (minus quotes) in the Service 
 R18 RPS Multiweight Air Type field 
 R19 RPS Prepaid Europe 
 R20 RPS Multiweight Europe 
 R21 RPS Multiweight Mexico 
 R22 RPS Prepaid 3-Day 
 R23 RPS Collect 3-Day 
 R24 RPS Multiweight 3-Day 
 S01 Shipped With Other Goods (post shipment) 
 S02 Shipped With Other Goods (pre shipment) 
 U01 UPS Next Day Air 
 U02 UPS Next Day Air Letter 
 U07 UPS 2nd Day Air 
 U08 UPS 2nd Day Air Letter 
 U11 UPS Ground 
 U16 UPS GroundSaver 
 U20 UPS Hundredweight Ground 
 U21 UPS 3 Day Select 
 U24 UPS Hundredweight 3 Day Select 
 U25 UPS Hundredweight 2nd Day Air 
 U26 UPS Hundredweight Next Day Air 
 U35 UPS 2nd Day Air A.M. 
 U36 UPS 2nd Day Air Letter A.M. 
 U43 UPS Next Day Air Saver 
 U44 UPS Next Day Air Saver Letter 
 U45 UPS Hundredweight 2nd Day Air A.M. 
 U46 UPS Hundredweight Next Day Air Saver 
 U48 UPS Shipment Standard Service to Can 
 U49 UPS Shipment Express Service Intl 
 U54 UPS Shipment Expedited Service Intl 
 U60 UPS Early A.M. 
 U61 UPS Early A.M. Letter 
 U63 UPS Shipment Express Plus Service Intl 
 U64 UPS Express Service Intl 10KG Box 
 U65 UPS Express Service Intl 25KG Box 
 U66 UPS Express Plus Service Intl 10KG Box 
 U67 UPS Express Plus Service Intl 25KG Box 
 U68 UPS Express Service Intl Letter 
 U69 UPS Express Plus Service Intl Letter 
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Appendix D: FedEx Code & Service Fields 
List* 

Domestic (within the U.S.): Code Field = 001 
 
Service Field       Description
 
1 Priority Overnight 
2 Priority Pak 
3 Priority Box 
4 Priority Tube 
5 Economy 2 Day Package 
6 Priority Letter 
7 Standard Overnight Package 
8 Standard Overnight Letter 
9 Economy 2 Day Pak 
0    Economy 2 Day Letter 
A    Overnight Freight Service 
B    Two-Day Freight Service 
C    First Overnight Letter 
D    First Overnight Package 
F    Express Saver Package 
G    Express Saver Freight 
H    Express Saver Pak 
I    Express Saver Letter 
 
 

U.S. Export Packages (International): Code Field = 051 
 
Service Field       Description
 
1 International Priority 
2 International Priority Pak 
5 International Economy 
6 International Priority Letter 
A    International First Overnight 
B    International First Overnight Pak 
C    International First Overnight Letter 
D    FedEx 10 kg box 
E    FedEx 25 kg box 
 
 
 
* These Code and Service field designations are only applicable to FedEx Server. 
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